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Tutorials
Introduction
The best way to get started using Wirecast is to quickly work through all it’s main 
features. This tour presents a series of three tutorials, each designed to help you 
understand how to create and broadcast presentations using Wirecast. 

As you work through these tutorials, you will also become familiar with important 
Wirecast concepts and how you can use them to deliver high quality broadcasts. The 
more you know about Wirecast, the better it will serve your broadcasting objectives.

Because each tutorial builds on the skills and knowledge you learn in the previous 
tutorials, it is recommend that you take the tours in succession. Working through all the 
tutorials takes about thirty minutes.

As you gain hands-on experience creating video and audio presentations - which leads 
to a working knowledge of Wirecast and its components and architecture - you will 
gain proficiency in using Wirecast.

Tutorials
 Tutorial 1: Basic Concepts

 Tutorial 2: Editing Shots

 Tutorial 3: Broadcasting

Note: You can run all of the tutorials without a license. However, a watermark on the 
video and an occasional voice-over on the audio are present until a valid license is 
activated. 

Note: For licensing information, select Preferences from the Wirecast menu, click the 
Add (+) button, then click Purchase. Or, contact sales@telestream.net.

http://www.telestream.net/vantage/help
mailto:sales@telestream.net
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Tutorial 1: Basic Concepts
The goal of this tutorial is to provide you with a quick but successful experience 
creating and broadcasting a presentation using Wirecast. This tutorial requires that you 
open the tutorial document in Wirecast. To do this, select Create Document for Tutorial 
from the Help menu in Wirecast. A new window will open as shown below:

Figure 35. Main window in Tutorial

The Main Window
Wirecast has two main display areas: Live Broadcast and Shot List. The Live Broadcast is 
the large area in the upper portion of the window displaying what Wirecast will 

Note: If you are running the tutorial with Wirecast in demonstration mode, the 
Wirecast logo will appear from time to time and audio output will have a periodic 
voice-over.
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broadcast to your viewers (or record to disk). The Shot List, in the lower half of the 
window, displays the shots available for broadcast:

Figure 36. Live Broadcast Area and Shot List 

What Is a Shot?
Wirecast uses the concept of a shot to construct presentations. A shot contains media, 
along with the settings for that media. In its simplest form, a shot contains one piece of 
media such as a photo or a video clip. But it can also be something more complex, like a 
live camera with a title, and background music.

A shot can be edited and its settings can be changed (See Tutorial 2: Editing Shots). 
Shots are important because they enable you to configure a lot of information before 
you broadcast your presentation. This enables you to concentrate on creating a good 
production during your broadcast. 

Switching Between Shots
Individual shots are displayed in the Shot List. Click the Ripples shot in the Shot List area 
and the image fades into the Broadcast Area display. This is called taking a shot live. 
Click the shot labeled Blank Shot and the Ripples image fades to a blank screen. The 
Blank Shot enables you to display nothing, which is sometimes useful. 

Transitions and Go Button 

Transitions
In the previous examples, a fade occurred when you clicked on a shot. This is because a 
smooth transition is the default. Transition controls are located just below the 

Live Broadcast area

Shot List

Ripples shot
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Broadcast Area where three kinds of transitions are shown: Cut, Smooth, and 
Bowstring.

Figure 37. Transition Control Panel

When Cut is selected, transitions are immediate. When Smooth is selected, transitions 
fade in (as demonstrated above). Select Bowstring to implement the transition with a 
wave effect (like a bow string when it is released).

To see the Bowstring effect, Click the River shot to place it in the Broadcast Area. Next, 
click the Bowstring button. The Transition panel should like this: 

Figure 38. Bowstring Transition Control

Now click the Ripples shot. The Ripples shot will appear using the Bowstring (wave) 
effect. 

There are more than just three kinds of transitions to choose from, but only three can 
be assigned to the Transition Panel. To select a different transition type, click the small 
arrow on the right side of the transition button. When the list appears, select a new 
transition to be assigned to this button. You can also click the transition button and 
drag the mouse downward until a menu of selections is displayed.

For example, change the first button (Cut) to be Swoop by clicking on the Cut button 
and dragging downward until the menu appears. Next, select Swoop from the menu. 
Swoop should now be selected for the first button. Now click back and forth between 
River and Ripples using Swoop.

These three transition buttons can also be selected by using the following key 
combinations: Command+1, Command+2, and Command+3. 

Transition Speed 
You can also Control how fast a transition will occur, by clicking the Clock (Transition 
Speed) icon: 

Figure 39. Transition Speed Icon
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Click on the clock icon and choose Slow from the menu. When Slow is selected, the 
clock icon changes to a small turtle, indicating slow mode: 

Figure 40. Slow Transition Icon

In Slow mode, when you perform a transition it will occur slower than normal. When 
faster transitions are selected, the icon changes to display a rabbit.

Go Button 
The Go Button (or Command+G) enables you to make a transition occur at any time.

Figure 41. The Go Button

Clicking the Go button does nothing when Wirecast is in its default mode of AutoLive. 
Later in this tutorial you will discover how to use the Go button to transition between 
different shots when the AutoLive mode is off.

Layers 

Wirecast enables you to use several layers. Layers are different kinds of displays (shots, 
logos, titles, etc.) placed on top of each other so that all are seen at the same time. It is 
an excellent way to add and remove objects in your broadcast. 

To open the Layer Panel, select Layer Panel from the Layout menu at the top of the Main 
window. You can also open the Layer Panel by hovering over the narrow grey panel on 

Note: Before you start this section, please select Smooth as your transition.
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the left side of the Shot list until a double arrow is displayed, then clicking and dragging 
to the right until the Layer Panel is displayed: 

Figure 42. Two Ways to Open the Layer Panel

Click and drag to the right

Select Layout > Layer Panel
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Layers are displayed in a particular order: Master Layer 1 is on top, Master Layer 2 below 
it, Master Layer 3 below Layer 2, etc. This tutorial, so far, has been operating on Master 
Layer 3. 

Figure 43. Layer Panel Display

Now select Master Layer 2 by clicking it. Each shot is assigned to a particular layer, so 
when you switch layers you only see the shots that are on that layer. For example, 
Ripples, River, and Blank shots are on Master Layer 3 (as seen previously in this tutorial), 
but Master Layer 2 has only a logo and a blank shot. 

Figure 44. Master Layer 2 Shots

Layer Panel

Master Layer 3
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Click on the shot named Logo. Notice that the Logo fades into the top-right corner of 
the Live Broadcast area: 

Figure 45. Logo Shot Added

Layers can also be made invisible by unchecking the checkbox for that layer. 
Unchecking Master Layer 2 causes the Logo to be removed from the Broadcast area.

Figure 46. An Unchecked Layer

Re-check the Master Layer 2 check box and the Logo will reappear.

Auto Live 

Uncheck to make 
layer invisible

Note: Before you start this section, please make sure that all layers are visible (all 
layer check boxes are checked), and that you are on the Master 3 Layer, which shows 
Ripples and River shots.
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Figure 47. Master 3 Level with All Layers Visible

So far in this Tutorial, Wirecast has been running in AutoLive mode. What this means is 
that any change you make on the Main window is automatically made live in your 
Broadcast. This mode is very useful for those users who wish to set up all of their shots 
at once and then single-click them as they run their presentation. But the disadvantage 
of this single-click method is that you can only see one shot change at a time. Once you 
click a shot, your viewers also see it (with no preview of how it will look on your part). 

Turn AutoLive Off 
Turn AutoLive off by unchecking AutoLive in the Switch menu. A dialog box will be 
shown informing you that AutoLive mode is off and transitions must be made using the 
Go button. Click OK in the dialog box to continue.

Try clicking the Ripples and River shots. Nothing happens because AutoLive mode is 
off. Now click the Ripples shot and click the Go Button. The Ripples shot is taken live in 
the Broadcast area. Click the River shot and, as expected, nothing happens. Click the Go 
button and River shot becomes Live. 

Multiple Changes
The benefit of having AutoLive off is that you can make several changes first and then 
have them occur all at the same time. To do this, verify that AutoLive is off and click the 
Ripples shot (you should still see River in the Live window). 

Note: When AutoLive is off, you must always click the Go button (or press the 
Command+G keys) to display the selected shot in the Broadcast area. 
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Now click Master Layer 1 in the Layers Panel and click Sample Title. Click the Go button 
(or Command+G) and notice how both the Ripples shot and the Sample Title shot 
become Live at the same time.

Preview 

One issue you may have noticed while running this tutorial is that you cannot see the 
changes you are making before broadcasting them. To solve this problem, Wirecast 
enables you to see a Preview of what you will broadcast. 

Select Preview from the Layout menu. The Left side of the Main window is the Preview 
area. Notice that it has a small green square with the letter P inside it. The Right side is 
the Live Broadcast area as before. Your Main window should now look like this: 

Figure 48. Main window with Preview Display

Note: Before proceeding, make sure Master Layer 3 is selected, and the Ripples shot 
is also selected.

Preview window

Green square 
with P
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Turn off Master Layer 1 and Master Layer 2 by unchecking both checkboxes. This 
removes the logo and title from the Preview. Now click the Go button to transition the 
Preview into the Broadcast area: 

Figure 49. Unchecked Master Layers 1 & 2
WireCast Tutorial |  81573 February, 2012
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Tutorial 2: Editing Shots
The first tutorial used only the Main window, and explained various ways in which you 
can use an existing shot. But shots can also be created and edited. This tutorial 
demonstrates how to edit your shots to meet your presentation needs.

Shots can be configured in different ways. Some shots have only titles and some just a 
logo, others have only a photo. Shots are created to be used in broadcast presentations. 
When you broadcast you are choosing, in real time, the shot you wish to display. Shot 
editing enables you to make shots you need for your broadcast. 

Figure 50. Tutorial Main window

Shot Editor Overview
Double click the Ripples Shot. This opens the Shot Editor window. 

Note: Before you start this tutorial, create a new tutorial document by selecting 
Create Document Tutorial from the Help menu. You should see a new Main window as 
shown below:

Note: If you save a document with the Shot Editor window open, Wirecast 
remembers this and will re-open the edit window when the document is re-opened. 
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The Shot Editor window has three main areas: Shot Preview, Configuration Area, and 
Source Layers.

Figure 51. Shot Editor window

Shot Preview This area shows exactly what this shot will look like to your viewers when 
you take this shot live. 

Configuration Area This is where you make changes to the content of the shot, and set 
it's parameters. The configuration area changes appearance depending on the selected 
Source Layer. Click the source icon in the configuration area and it will become invisible 
in the Preview.

Source Layers This area enables you to add, remove, and reorder the sources in your 
shot. Sources are ordered visually from top to bottom. For example, the first source in 
the Source Layer List will appear on top of all other sources in the preview. This list also 
controls visibility of each of the elements in the shot. 

Source Layers 
The bottom left part of the Shot Editor window lists the sources that make up your shot. 

Figure 52. Shot Sources

Click on the Logo icon (source) in the Configuration Area. Notice that the Logo is 
displayed in the Shot Preview area. Click the Ripples icon (source) and the Preview 
switches to Ripples. This is how you change the source media for this layer in the shot. 

Shot Preview

Configuration area

Source Layers

Source 
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Template Window
The Template window icon is located in the controls bar in the middle of the window. 

Figure 53. Template window Icon

Click on the template window icon to open the Template window. Select the Angled In 
template and click the Apply button: 

Figure 54. Template window

Notice the Preview has changed again in the Shot Editor window, and now shows the 
Ripples image on the Left side. This is because the template selected has an A and a B 
portion to it. Two different sources can be assigned to A and B, but for now only A is 
assigned (with the Ripples source):

Figure 55. Shot Using Template

Select Angled In

Click Apply
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Sources in Wirecast can be assigned either A, B or C in the Source Layers list. To change 
the assignment, click the A (or B or C) icon and make a selection. This makes choosing a 
new template much simpler because Wirecast automatically positions the correct 
sources on screen.

For example, to change the media for the source that is identified as B, select the source 
identified as B, then click the River icon in the Configuration area. Your Preview should 
now look like this: 

Figure 56. Preview with New Media Source

Titles 
You can also add a title to a shot. First click the plus (+) button on the bottom of the 
Source list to add a new layer: 

Figure 57. New Layer Added

Click on the B source

River source is displayed as 
B in Preview

Click on the River icon

Click the 
plus button

New source 
layer added
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To add a title template, click the T button on the control panel: 

Figure 58. Title Template Icon

Select the title template called Blue Banner 3 (items are not listed alphabetically) and 
your preview will add the title: 

Figure 59. Blue Banner 3 Selection

Next, click the T icon in the Attributes bar to enable text editing: 

Figure 60. Edit Text window

Click T button

Blue Banner 3 
displayed

Select Blue 
Banner 3

Click T
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Type text into lines 1 & 2 and it will display in the preview window: 

Figure 61. Added Text

Effects/Motion 

Positioning Objects 
The sources in a shot can be positioned anywhere on the on screen. Make sure Blue 
Banner 3 is selected. Click the Effects tab in the Shot Editor. 

Figure 62. Effects window Display

Though the title element is initially placed in the bottom middle of the Preview screen, 
it can be moved anywhere. To move the title, click and drag it to a new location. You can 
also move the title to an edge, corner, or center by clicking on one of the repositioning 
buttons in the configuration area:

Figure 63. Repositioning Controls

You can also resize or rotate the title. 

Two lines of text added

Click the effects tab

Select Blue Banner 3

Click a repositioning button 
to move the title
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To resize the title (while respecting aspect ratio), hold the Command key down while 
moving the mouse vertically. To resize (independent of the aspect ratio), hold the 
Command key and the shift key down while moving the mouse vertically and 
horizontally. The Respect Aspect Ratio checkbox in the configuration area must be 
unchecked.

To rotate the title, hold down the Option key while moving the mouse vertically and 
horizontally. 

Motion for Objects 
All objects (including the title) can have motion assigned to them. Click the Motion tab, 
to open the Build-In/Build-Out configuration panel: 

Figure 64. Motion window

Motion will only occur during a transition (when you click Go, or click a shot in AutoLive 
mode). Motion defines how to add (Build-In) or remove (Build-Out) a shot element. 

There are two forms of Motion: 

1. Build-In (add) Build-In motion occurs when the shot is added to the Live Broadcast 
display. 

2. Build-Out (remove) Build Out motion occurs when the shot is removed from the Live 
Broadcast display. 

Click the Motion tab

Build-in / Build-out 
configuration panel
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Changing Motion Options 
Click the menu under Build-In in the configuration area and select From Left. Also check 
the Decelerate In checkbox: 

Figure 65. Motion Control Selections

To see this behavior in action, you must go back to the Main window and trigger the 
Build-In action,. To do this, follow these steps:

1. Close the Shot Editor window by clicking the X in the upper-left corner of the 
window.

2. In the Main window, make sure Smooth transition is selected. 

3. Click on the Blank Shot, then click the Ripples shot (recently edited). 

Notice that when the Title appears it comes in from the left. 

Select “From Left”

Check Decelerate In
WireCast Tutorial |  81573 February, 2012
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Tutorial 3: Broadcasting
This tutorial demonstrates how to setup and broadcast your Wirecast presentations. 
You can broadcast to a specific computer (Unicast), multiple viewers (Multicast), or 
even record your broadcast to disk.

There are two main components for broadcasting your presentation (or saving it to 
disk): 

1. Encoding You need to decide how you are going to encode the broadcast. Encoding 
is the type of compression you will use (JPEG, MPEG4, etc.). Wirecast comes 
configured with many common encoding options. 

2. Destination A destination for the broadcast must be selected. You can send it to a 
server for broadcast or save it to disk.

Broadcast Settings 
To display the Broadcast Settings window, select Broadcast Settings from the Broadcast 
menu (or press the Command+Y keys).

Multiple settings for the same broadcast can be listed in the top part of the Broadcast 
Settings window. For example, you might want to create a broadcast with multiple bit-
rates for viewers using different internet connections. You may also want to record to 
disk while broadcasting your presentation. To add a new broadcast setting to the list, 
click the plus (+) button.

Use the Encoder Preset menu to select how your broadcast will be encoded (which 
CODEC to use). For the purpose of this tutorial, select any of the encoders, or just use 
the default setting. 

Configuration options depend on the encoder selected. Only two streaming types are 
available: QuickTime and Flash. 

Use the Destination menu to select the destination of your broadcast. Most of these are 
remote server locations, but the last option enables you to save your broadcast on your 
local disk.

Figure 66. Broadcast Settings window

Broadcast settings list

Click to add a new setting

Select encoder

Select destination
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QuickTime Streaming 
From the Encoder Preset menu, select DSL/Cable-MPEG4. This is one of several 
QuickTime encoders provided.

Figure 67. QuickTime Streaming Setup window

Wirecast provides five destinations for QuickTime streaming: 

1. Announce to QuickTime Streaming Server This will talk to a QuickTime Streaming 
Server and use the server to send the broadcast to users who view that server. (This 
is the default destination.)

2. Built-in Streaming Server Wirecast includes a built-in streaming server which will 
allow a small number of viewers to view your broadcast. Define the name of the SDP 
file and you can immediately broadcast. 

3. Unicast This will broadcast directly to one single client (computer). You must define 
the address for the single client, then the presentation is streamed directly to that 
computer. 

4. Multicast This is an advanced feature that will broadcast globally on a network. In a 
LAN environment, this option can provide the ability to broadcast to multiple users 
without using QuickTime Streaming Server. This feature only works over a LAN, not 
over the Internet. 

5. Record to Disk If you want to save your broadcast, you can use this option to record 
the broadcast stream to disk. 

Announce to QuickTime Streaming Server
Since this is the most common method for QuickTime, you should always consider 
using this option for your broadcast. To use this feature, you must supply a host name 
and file location. You need to supply a user-name and password only if your server 
requires a login. 

Note: Clicking in the list area on a location that de-selects all the settings creates a no 
output state. This is corrected by clicking any setting on the list.

Select DSL/Cable-MPEG4
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This feature requires that you have access to a QuickTime Streaming Server (QTSS) or 
Darwin Streaming Server (DSS). Darwin Streaming Server is a free download from 
Apple and can be installed on many operating systems (not just Macintosh). 

Unicast
Unicast is used to broadcast to only one computer. To set up a unicast, follow these 
steps: 

1. Obtain the IP address of the target computer, and configure your broadcast using it. 

2. Save an SDP file on the target computer. 

3. Start broadcasting your presentation. 

4. The viewer must open the SDP file using QuickTime Player to see your presentation. 

Multicast
Multicast is used to broadcast to any computer on your local network (not the internet). 
To use this feature, you must create and distribute an SDP file to all users on your local 
network who wish to view the stream. 

The Video Address and Audio Address (and related ports) are, effectively, fake 
addresses that do not really exist on the local network. This information is stored in the 
SDP file so that client applications know where to look for the stream. The default 
addresses/ports that Wirecast generates are generally sufficient to use. 

To set up a multicast, follow the same step given for Unicasting. (See Unicast, 
immediately preceding.) 

Record To Disk
If you wish to archive your stream, you can use the Record To Disk destination. The only 
setup information required is the filename. If you use Auto Increment Filenames then 
all files will be saved with a sequential number appended to them. 

Flash Streaming
Select Flash Medium Bandwidth from the Encoder Preset menu. Wirecast can stream to 
several Flash streaming servers, including Flash Media Server (Adobe) and Wowza 
Streaming Server (Wowza).

Note: If you change any setting regarding the broadcast (encoding settings, etc), you 
must re-create and re-distribute the SDP file. 
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When you configure Wirecast to stream using Flash, Wirecast displays a Flash queue bar 
in the main window. The Flash queue shows you how much data is currently buffered 
on your computer, waiting to be transferred to the server.

Figure 68. Flash Streaming Setup window

Encoder Preset
Encoder Preset enables you to select an encoder used for broadcast. If you change the 
preset to another encoder type, the list of destinations associated with it will also 
change. The destinations are tied to the type of codec you are using. 

Destination
The Destination menu lists many CDN’s and live streaming Websites. You need to have 
an account with the selected destination to use that service. You can also select Record 
to Disk as a destination for your presentation. The RTMP Flash Server is the default 
destination.

Address
The address of the selected destination is obtained from your Flash Media Server 
administrator for this URL.

Stream
Each Flash stream requires that you enter the name of the stream. Contact your Flash 
Media Server administrator to obtain this name.

Open FMLE XML File 
Wirecast can load configuration files that have been created for Flash Media Live 
Encoder (FMLE). Wirecast will read the RTMP Address and Stream Name from this file, 
but it will not read any other configuration information from the FMLE XML file (bit 
rates, codec configuration, etc.). Many popular sites provide an FMLE configuration file 
for your stream configuration.

Select Flash Medium 
Bandwidth
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User Agent
Although rare, some streaming services require that Wirecast presents itself as FMLE 
when broadcasting. By default, Wirecast correctly presents itself as Wirecast/FM 1.0. Do 
not change this unless your provider has asked you to do so.

Set Credentials
Some Flash Media Servers require authentication. Wirecast offers the standard Adobe 
authentication method. However, if required to do so by your server, you must enter 
your credentials here. But if your server does not require authentication, there is no 
need to provide these credentials.
February, 2012 WireCast Tutorial |  81573


	Wirecast for Mac OS X Version 4.1 User’s Guide
	Tutorials
	Introduction
	Tutorials

	Tutorial 1: Basic Concepts
	The Main Window
	What Is a Shot?
	Switching Between Shots

	Transitions and Go Button
	Transitions
	Transition Speed
	Go Button

	Layers
	Auto Live
	Turn AutoLive Off
	Multiple Changes

	Preview

	Tutorial 2: Editing Shots
	Shot Editor Overview
	Source Layers
	Template Window

	Titles
	Effects/Motion
	Positioning Objects
	Motion for Objects
	Changing Motion Options


	Tutorial 3: Broadcasting
	Broadcast Settings
	QuickTime Streaming
	Announce to QuickTime Streaming Server
	Unicast
	Multicast
	Record To Disk

	Flash Streaming
	Encoder Preset
	Destination
	Address
	Stream
	Open FMLE XML File
	User Agent
	Set Credentials






